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Configuração do HW Os módulos são fornecidos de fábrica com parâmetros pré-selecionados. Se estes 
parâmetros de fábrica estiverem OK não é necessário fazer a configuração do HW.
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parâmetros de fábrica estiverem OK não é necessário fazer a configuração do HW.

É necessário fazer uma configuração:
• se for necessário modificar os parâmetros pré-selecionados ou endereços de 
um módulo (por ex. ativar a interrupção de hardware de um módulo); 

• se for necessário configurar redes de comunicação;                                                    
• se existem estações de periferia distribuída (PROFIBUS-DP);                                 
• se existem estações S7-400 com várias CPUs (multiprocessamento) ou 
bastidores de expansão;                                                                                          •

se o controlador lógico programável for do tipo “fault-tolerant” (pacote opcional).

Configuração Ao configurar o sistema é criada uma configuração prevista para o mesmo
Prevista (setpoint configuration). Ela contém a estação de hardware com os módulos 

planejados e seus respectivos parâmetros. O sistema utilizando o PLC é montado 
de acordo com a configuração prevista, e durante o comissionamento esta 
configuração é transferida para a CPU. 

Configuração Atual Num sistema montado, a configuração atual existente e a atribuição de parâmetros 
dos módulos pode ser lida da CPU. Uma nova estação de HW é, portanto, 
estabelecida no projeto. 

Isto é necessário, por exemplo, se a estrutura do projeto não existe localmente no 
PG. Após a configuração atual ter sido lida, os parâmetros selecionados podem ser 
verificados e armazenados num projeto. 

Notas No S7-400 podem ser atribuídos parâmetros à CPU de forma que, se houver 
diferenças entre a configuração prevista e a configuração atual, o startup da CPU é 
interrompido. 

Para chamar a ferramenta de configuração do HW deve existir uma estação de 
hardware no SIMATIC Manager.



Insert Station 
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Para inserir uma nova estação de hardware no projeto atual selecione a seqüência 
de menus Insert -> Station ->  SIMATIC 300 Station  ou SIMATIC 400 Station. 

O nome automaticamente dado à estação é "SIMATIC 300 (1)“, e pode ser alterado 
posteriormente. 



HW Config Esta ferramenta ajuda a configurar, a atribuir parâmetros e a diagnosticar o 
hardware. 
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hardware. 

Iniciando Para iniciar a ferramenta de configuração do HW:

• selecione uma estação de hardware no SIMATIC Manager e escolha a 
seqüência de menus Edit --> Open Object  ou

• duplo-clique no objeto Hardware.

"Hardware Janela da aplicação do "HW Config“, utilizada para inserir os componentes
Configuration" da janela "Hardware Catalog". 

A barra de título desta janela contém o nome do projeto e o nome da estação. 

"Hardware Catalog" Para abrir o catálogo:

• selecione a seqüência de menus  View -> Catalog  ou

• clique no ícone           da barra de ferramentas.

Se estiver selecionado como perfil de catálogo a opção “Standard”, ficam 
disponíveis para seleção todos os bastidores, módulos e módulos de interface na 
janela "Hardware Catalog".

É possível criar um catálogo personalizado com os elementos utilizados com maior 
freqüência, bastando para isso selecionar a seqüência de menus Options -> Edit 
Catalog Profiles.

Os escravos Profibus que não existem no catálogo podem ser acrescentados. Para 
isso, deve-se utilizar os arquivos designados GSE, que são fornecidos pelo 
fabricante do elemento escravo. Os arquivos GSE contêm a descrição do 
dispositivo. Para incluir o escravo no catálogo de hardware, utiliza-se a seqüência 
de menus Options -> Install New GSE Files e depois Options -> Update Catalog. A 
partir daí os novos elementos no catálogo podem ser encontrados dentro do campo 
de dispositivos adicionais Profibus.



Gerando a  Gerar a configuração prevista significa especificar como os módulos devem ser
Configuração montados no bastidor. No STEP 7 esta configuração é tratada por “setpoint 
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Configuração montados no bastidor. No STEP 7 esta configuração é tratada por “setpoint 
Prevista configuration”. 

Bastidor Por exemplo, ao configurar uma estação SIMATIC 300:
O catálogo "RACK-300" contém um ícone para um trilho DIN. É possível inseri-lo 
na janela "Hardware Configuration” com um duplo-clique (ou arrastando-o com o 
mouse).  

Aparecem então duas listas de bastidores separadas: uma lista com o tipo de 
módulos em cima e uma lista detalhada com referências, endereços MPI e 
endereços de I/O embaixo. 

Fonte de Pode-se inserir uma fonte de alimentação com um duplo-clique, ou arrastando 

Alimentação com o mouse o módulo "PS-300" do catálogo, para o slot nr.1 do bastidor.

CPU A CPU é inserida do catálogo "CPU-300“, no slot nr.2. 

Slot Nr. 3 O slot nr. 3 está reservado como endereço lógico para o módulo de interface (para 
configurações com vários bastidores). 

Se esta posição deve ser reservada na configuração atual para uma posterior 
instalação de uma IM, deve-se inserir um módulo DM370 (DUMMY).  

Módulos de Sinal A partir do slot nr. 4 é possível inserir uma número máximo de até 8 módulos de 
sinal (SM), processadores de comunicação (CP) ou módulos de função (FM). 

Para inserir os módulos no bastidor selecione o slot e depois dê um duplo-clique no 
módulo desejado contido no catálogo. 

É possível inserir módulos em qualquer parte da lista arrastando com o mouse.



Números de Slot Os números de slot no bastidor do S7-300 simplificam o endereçamento da série. 
O endereço inicial do módulo é determinado pela sua posição no bastidor.
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O endereço inicial do módulo é determinado pela sua posição no bastidor.

Slot 1 Fonte de Alimentação.
O módulo de fonte de alimentação não é absolutamente essencial. Um S7-300 
pode ser alimentado com 24V diretamente.

Slot 2 Slot para a CPU.

Slot 3 Logicamente reservado para um módulo de interface (IM), para configurações 
multi-rack utilizando bastidores de expansão. Mesmo se não houver módulo IM 
instalado ele deve ser considerado para fins de endereçamento.

É possível reservar o slot (por ex. para futura instalação de um IM) inserindo um 
módulo DM370 (dummy module).

Slots 4-11 O Slot 4 é o primeiro slot que pode ser utilizado para módulos de I/O, 
processadores de comunicação (CP) ou módulos de função (FM). 

Exemplos de endereçamento:

• Um módulo DI no slot 4 inicia no byte de endereço 0.

• O primeiro LED de um módulo DO no slot 6 é definido por Q8.0.

Nota 4 bytes de endereço são reservados para cada slot. Se forem utilizados módulos 
DI/DO de 16 canais, dois bytes de endereço serão perdidos em cada slot!



Configurações Os slots também possuem endereçamento fixo na configuração multi-rack.
Multi -rack
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Multi -rack
Exemplos:

• Q7.7 é o último bit de um módulo DO de 32 canais no slot 5 do rack 0.

• IB105 é o segundo byte de um módulo DI no slot 6 do rack 3.

• QW60 são os primeiros 2 bytes de um módulo DO no slot 11 do rack 1.

• ID80 são todos os 4 bytes de um módulo DI de 32 canais no slot 8 do rack 2.



R número do bastidor

S número do slot do módulo em questão
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S número do slot do módulo em questão

DP apenas relevante quando se utiliza periferia distribuída (I/O) 

IF ID do módulo de interface quando se programam sistemas M7 (em C++).

Atribuição Livre Quando se utiliza a CPU 315-2DP é possível atribuir endereços aos módulos  
de Endereços independentemente das posições em que estão instalados: 

1. Inicie a Configuração do HW

2. Duplo-clique nos módulos cujos endereços deseja alterar. A janela “Properties“ 
se abre.

3. Selecione o endereço inicial desejado em "Addresses". 
O endereço final é automaticamente atualizado pelo sistema.



Endereçamento Os módulos do S7-300 (CPUs sem interface DP) e S7-400 (sem
Fixo configuração de hardware) têm atribuído endereçamento fixo para o slot onde são 
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Fixo configuração de hardware) têm atribuído endereçamento fixo para o slot onde são 
colocados. 

Endereçamento Com o S7-300 (CPUs com interface DP integrada) e com o S7-400 é possível
Variável atribuir parâmetros aos endereços iniciais dos módulos.

O Que Fazer Ao dar um duplo clique num módulo digital ou analógico aparece a tela para 
atribuição de parâmetros. Depois de escolher a opção “Addresses”, pode-se retirar 
a seleção de “System default”. É possível então definir o endereço inicial no campo 
“Start“. Se o endereço já estiver sendo usado aparece uma mensagem de erro. 

“Part Process Image“ só pode ser definida no S7-400. Assim sendo, entradas e 
saídas específicas (por ex. sinais de tempo-crítico) podem ser combinadas num 
grupo. Uma função do sistema dispara a atualização da partição da imagem de 
processo no programa do usuário. 

Nota Após um reset de memória da CPU (como conseqüência disso), os parâmetros e 
os endereços são perdidos. Isto significa que no S7-300 são válidos mais uma vez 
os endereços fixos por slot e com o S7-400 os endereços default. 



Símbolos É possível acessar a tabela de símbolos da estação de HW a partir da ferramenta 
"HW Config“; assim a tabela de símbolos pode ser criada ou modificada durante a 
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"HW Config“; assim a tabela de símbolos pode ser criada ou modificada durante a 
configuração de hardware. 

Selecionando o módulo com a tecla direita do mouse pode-se abrir a tabela de 
símbolos na opção de menu Edit Symbols. 

Monitorando/ É possível monitorar ou modificar o estado lógico nos módulos configurados

Modificando diretamente através da ferramenta de configuração de hardware. Com a função

Variáveis Monitor Variables é possível checar a conexão nos módulos de entrada e com

a função Modify Variables é possível checar a conexão nos módulos de saída.

Nota O endereçamento simbólico e a edição da tabela de símbolos é visto com maiores 
detalhes no capítulo “Símbolos”; a função de teste Monitor / Modify Variables é 
vista no capítulo “Solução de Problemas”.



Ciclo • Opção "Scan cycle monitoring time (ms):"

- Se esse tempo for excedido a CPU entra em STOP.                          
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- Se esse tempo for excedido a CPU entra em STOP.                          
Possíveis causas para o tempo excedido: Processos de comunicação,
que freqüentemente aparecem a partir de interrupções, erros no 
programa da CPU.

- Se o bloco de erro OB 80 foi programado o tempo de ciclo é duplicado. 
Após esse tempo a CPU também entra em STOP. 

• Opção “Scan cycle load from communication (%):"

- A comunicação (por ex. transmissão de dados para outra CPU via MPI 
ou funções de teste que foram iniciadas pelo PG) é limitada à 
porcentagem especificada do tempo de ciclo atual.

- Limitar a carga de ciclo pode atrasar a comunicação entre a CPU e o 
PG.

- Exemplo: Limitar a comunicação em 20% resulta numa carga máxima 
para comunicações de 20ms para um tempo de ciclo de 100ms 

Tamanho da Com a CPU 318-2 e algumas CPUs do S7-400 é possível especificar o
Imagem de Processo tamanho da imagem de processo (em bytes). A área da imagem de processo 

começa sempre a partir do byte 0 de entrada ou saída. 

Clock Memory São bits de memória que mudam seu valor binário periodicamente.

Cada bit do clock memory está atribuído a um determinado período / freqüência.

Exemplo de uma luz piscando com uma freqüência de intermitência de 0.5Hz:
(Período = 2s, luz ON = 1s, luz OFF = 1s).



Salvar Para salvar a configuração atual no projeto atual selecione a seqüência de menus
Station->Save (não são criados blocos de dados de sistema - SDBs).
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Station->Save (não são criados blocos de dados de sistema - SDBs).

Salvar e Compilar Selecionando a seqüência de menus Station->Save and Compile ou clicando no 
ícone da barra de ferramentas, os dados de configuração e de atribuição            

de parâmetros também são armazenados nos blocos de dados de sistema. 

Verificação da Selecionando a seqüência de menus Station -> Consistency Check verifica-se
Consistência se é possível gerar a configuração de dados a partir do que foi feito. 

Transferência Selecionando a seqüência de menus PLC -> Download ou clicando no ícone           
da barra de ferramentas é possível transferir a configuração selecionada 

para o PLC. O PLC tem que estar no estado "STOP“!

Blocos de Dados Os SDBs são gerados e modificados quando se configura o hardware.
de Sistema Os blocos de dados de sistema (SDBs) contêm os dados da configuração e os 

parâmetros do módulo, e são armazenados na memória de trabalho da CPU 
quando da sua transferência. Isso facilita a substituição de módulos, porque os 
dados de atribuição de parâmetros são transferidos para o novo módulo a partir dos 
blocos de dados de sistema no startup da CPU. 
No terminal de programação, os blocos de dados de sistema são armazenados no 
caminho: Project \ Station \ CPU \ S7_program \ Blocks \ System_data.
Para abrir a lista de blocos de dados de sistema dê um duplo-clique no
ícone 

Se estiver utilizando um módulo Flash EPROM, os SDBs também devem ser nele 
armazenados. Assim sendo, a configuração não se perde se estiver trabalhando 
sem bateria de back-up e ocorrer uma falha na alimentação da CPU. 



Introdução A configuração só é necessária nos seguintes casos:

• para alterar as características pré-definidas para os módulos
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• para alterar as características pré-definidas para os módulos

• para estações com I/O distribuído

• para o S7-400 com várias CPUs ou com bastidores de expansão.

É possível ler a configuração atual existente na CPU, para analisar os parâmetros 
atribuídos a um sistema existente.

Configuração Atual Durante o startup a CPU gera uma configuração atual, isto é, ela salva a disposição 
dos módulos e atribui os endereços de acordo com um algoritmo fixo. Se não 
tiverem sido atribuídos parâmetros são utilizados os parâmetros de fábrica default. 

O sistema armazena esta configuração atual em blocos de dados de sistema. 

Transferência para Existem duas maneiras de transferir a configuração atual para o PG:                

o PG 1. No SIMATIC Manager:
através da seleção de menus PLC -> Upload Station.

2. Na ferramenta HW Config:
através da seleção de menus PLC -> Upload  ou selecionando o ícone         .

Armazenamento A configuração atual lida a partir do hardware instalado é inserida como uma 

no PG nova estação no projeto selecionado no PG. 

Nota Ao ler a configuração atual, as referências dos módulos não podem ser 
completamente identificadas. Por esta razão, deve-se verificar a configuração e, se 
necessário, inserir o tipo de módulo exato dentre os módulos existentes. Para isso, 
selecione o módulo, e a seqüência de menus Options -> Specify Module.



Objetivo: Como o “Projeto_1” ainda não possui estação de hardware será transferida a 
configuração atual do PLC contida no kit de treinamento. A nova estação de 
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configuração atual do PLC contida no kit de treinamento. A nova estação de 
hardware criada será renomeada para “Estacao_1”.

O Que Fazer • Inicie o SIMATIC Manager e abra o "Projeto_1“;

• Carregue a configuração atual do kit de treinamento no projeto
SIMATIC Manager -> PLC -> Upload Station 
Complete a caixa de diálogo de acordo com a figura acima

• Renomear a nova estação de hardware "SIMATIC 300(1)" para “Estacao_1"
clique duas vezes em "SIMATIC 300(1)" (não um duplo-clique !) para 
renomear.

Resultado Agora no "Projeto_1" existe a estação de hardware “Estacao_1" e o programa 
independente de hardware "Programa_1" (veja a figura acima).



Objetivo: A configuração atual lida através do comando "Upload Station" está incompleta, 
devido aos códigos de encomenda (MLFB’s) faltantes. Eles são necessários, em 
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devido aos códigos de encomenda (MLFB’s) faltantes. Eles são necessários, em 
todo caso, para identificar claramente os módulos e atribuir parâmetros aos 
mesmos. Entre com os códigos de encomenda dos módulos do kit de treinamento 
(localizados no canto inferior das tampas dos módulos), substituindo aqueles que 
estão sem código.

O Que Fazer • Inicie a ferramenta HW Config
SIMATIC Manager (Offline view) -> selecione “Estacao_1" -> dê um
duplo-clique no objeto "Hardware"

• Substitua os módulos sem código de encomenda 
dê um duplo-clique no(s) módulo(s) -> na caixa de diálogo "Specify Module" 
escolha os módulos a serem substituídos de acordo com o kit de treinamento 

-> confirme a caixa de diálogo "Properties" com OK, se os parâmetros pré-
definidos não tiverem de ser alterados.

• Apenas se o seu kit de treinamento for um S7-400:
Especifique o endereçamento dos módulos de modo a corresponder aos 
módulos de 32 canais do kit de treinamento S7-300 (observe a figura). duplo-

clique no módulo -> especifique o endereço na caixa de diálogo Properties

• Salve e compile a configuração atual adaptada 
Station -> Save and Compile

• Transfira a configuração atual para a CPU
PLC -> Download

• Feche a ferramenta HW Config

Resultado A estação de hardware “Estacao_1" existente no "Projeto_1" corresponde 
exatamente ao kit de treinamento.



Objetivo: O “S7 Program(x)” da CPU criado através do comando Upload Station será 
substituído pelo programa independente de hardware “Programa_1“. 
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substituído pelo programa independente de hardware “Programa_1“. 

Nota Copiando o “Programa_1” para o “S7 Program(x)” da CPU você estará substituindo 
completamente o programa anterior contido na CPU. Para que os dados do 
sistema contendo a configuração e a atribuição de parâmetros não sejam perdidos 
é necessário inicialmente copiá-los do “S7 Program(x)” da CPU para o 
“Programa_1”.

O Que Fazer (veja passo-a-passo na figura acima)

1. Copie os dados de sistema da “Estacao_1" para o programa independente de 
hardware “Programa_1" arrastando-o com o mouse 

2. Copie o programa independente de hardware “Programa_1" para a CPU da 
“Estacao_1” arrastando-o com o mouse. 

3. Apague o programa independente de hardware “Programa_1".

Verifique se a estrutura do projeto corresponde à da figura 3.

Resultados A estrutura do projeto corresponde à do kit de treinamento. Ela contém a estação 
de hardware “Estacao_1”, com uma CPU cujo programa é chamado “Programa_1”.



Objetivo: Parametrizar a CPU de modo que o clock memory byte seja armazenado no 
memory byte MB 10.
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memory byte MB 10.

Checar o sucesso da parametrização usando a função Monitor/Modify Variables.

O Que Fazer: • Inicie a ferramenta HW Config 
SIMATIC Manager (Offline view) -> selecione “Estacao_1" -> duplo-clique 
no objeto "Hardware"

• Parametrize o memory byte MB10 como sendo o clock memory byte da CPU 
duplo-clique na CPU -> Cycle / Clock Memory

• Salve e compile a configuração modificada  
Station -> Save and Compile

• Transfira a configuração modificada para a CPU
PLC -> Download

• Feche a ferramenta HW Config 

• Monitore o memory byte MB10 no formato de exibição binário para poder 
observar as freqüências pulsantes individualmente.
no SIMATIC Manager selecione "Programa_1”  -> PLC -> Monitor/Modify 
Variable -> preencha o MB 10 como endereço na tabela de variáveis -> 
utilizando o botão direito do mouse especifique “binary” como formato de 
exibição -> ative a função usando 



Atribuindo Os parâmetros são atribuídos aos módulos para os adaptá-los às necessidades
Parâmetros do processo.
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Parâmetros do processo.

O que fazer:

1. Selecione um módulo na janela da estação. 

2. Duplo-clique no módulo selecionado para abrir a janela "Properties".

3. Esta janela possui 9 campos nos quais é possível atribuir parâmetros para as 
diferentes características da CPU (ver próximas páginas).



Opção "General" A seção "General" fornece informação sobre o tipo do módulo, sua localização e, 
no caso dos módulos programáveis, o endereço MPI.  
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no caso dos módulos programáveis, o endereço MPI.  

Endereço MPI Para conectar vários PLCs em rede através da interface MPI é necessário atribuir 
um endereço MPI diferente a cada CPU. 

Selecione o botão "Properties" para abrir a janela "Properties - MPI  Node", que 
contém duas seções: "General" e "Parameters".



Características de As CPUs do S7-300 e S7-400 têm diferentes características de startup.
Startup Por enquanto, vamos ver apenas as características de startup do S7-300. As 
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Startup Por enquanto, vamos ver apenas as características de startup do S7-300. As 
características especiais do S7-400 serão discutidas em outro capítulo. 

Restart O S7-300 apenas reconhece o "Complete restart". As CPUs mais novas 

Completo também possuem a versão "Cold restart“.

Tempos Monitorados • "Ready message from modules (x100ms):"
Tempo máximo para que todos os módulos enviem uma mensagem de que 
estão OK após power ON. Se os módulos não enviarem a mensagem de 
que estão prontos para a CPU dentro deste intervalo de tempo, a 
configuração atual não é igual à configuração prevista. Por exemplo, numa 
configuração com vários bastidores, todas as fontes de alimentação podem 
ser ligadas dentro deste tempo sem se tomar atenção a uma seqüência 
particular. 

• "Transfer of parameters to modules (x100ms):"
Tempo máximo para “distribuir” os parâmetros aos módulos com atribuição 
de parâmetros (a contagem deste tempo começa quando é enviada a 
mensagem "Ready message from modules“ para a CPU).
Se, decorrido o tempo de acesso, não tiverem sido atribuídos os parâmetros a 

todos os módulos, então a configuração atual não é igual à configuração prevista. 

Startup se as Apenas nas CPUs com interface DP integrada (e S7-400) pode ser utilizada a 
Configurações opção "Startup if preset configuration not equal to actual configuration“, para  
Prevista e Atual decidir se a CPU deverá executar o startup mesmo que a configuração prevista
são diferentes não seja igual á configuração atual (número e tipo de módulos instalados).

As outros CPUs do S7-300 entram em RUN quando a configuração prevista não é 
a mesma que a configuração atual. 



Memória Retentiva A seção "Retentive Memory" é utilizada para especificar as áreas de memória que 
devem ser mantidas após uma falha na alimentação ou numa transição de STOP 
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devem ser mantidas após uma falha na alimentação ou numa transição de STOP 
para RUN. 

No S7-300 é executado, em ambos os casos, um "complete restart“.

Restart Num restart completo, os blocos armazenados na RAM retentiva (OB, FC,
Completo com FB, DB), bem como os bits de memória, temporizadores e contadores definidos 
Bateria de Backup como retentivos são mantidos. Só os bits, temporizadores e contadores não-

retentivos são resetados. 

Restart Se não existe bateria para manter a RAM sua informação é perdida. Só os  
Completo sem bits de memória, temporizadores, contadores definidos como retentivos, além
Bateria de Backup das áreas dos blocos de dados definidas como retentivas são armazenados em 

área não-volátil da RAM. 

Depois de um restart completo sem bateria de backup o programa tem que ser 
transferido novamente:

• a partir do módulo de memória (se inserido); ou
• a partir do PG (se não existir módulo de memória).



Opção Pré-Definida Características pré-definidas (nível de proteção 1; não há password atribuído):
A posição da chave na CPU determina a proteção:  
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A posição da chave na CPU determina a proteção:  

• Chave na posição RUN-P ou STOP: sem restrições
• Chave na posição RUN: só é possível o acesso read-only (leitura)!

Password Se foi atribuído um nível de proteção com password (apenas válido até um reset de 
memória), a pessoa que sabe a password tem acesso para leitura e escrita. A 
pessoa que não sabe a password tem as seguintes restrições:

• proteção nível 1: corresponde às características pré-definidas

• proteção nível 2: é apenas possível o acesso read-only, 
independentemente da posição da chave                                                                  

• proteção nível 3: não é possível nem o acesso para leitura nem o acesso 
para escrita, independentemente da posição da chave.

Características de um Módulo em Operação com Proteç ão por Password 
Exemplo: para executar a função "Modify Variable" deve-se escrever a password 
para um módulo ao qual foi atribuído o parâmetro de nível de proteção 2. 

Direitos de Acesso É possível também introduzir a password para um módulo protegido no SIMATIC 
Manager:
1. Selecione o módulo protegido ou seu programa S7
2. Introduza a password selecionando a seqüência de menus PLC -> Access 

Rights. Os direitos de acesso, depois da password ter sido introduzida, são 
apenas válidos até que a última aplicação S7 seja completada. 

Operação A carga de ciclo para funções de teste é regulado com essa opção:                         
Na opção Process, funções de teste como "Monitor" ou "Monitor/Modify Variable" 
são limitadas de forma que o aumento do tempo de ciclo permitido não seja 
excedido. Testes com breakpoints e passos individuais (execução do programa 
linha a linha) não podem ser executados. 

Na opção Test, todas as funções de teste possíveis com PG/PC podem ser 
utilizadas sem restrições, mesmo que provoquem um aumento significativo do 
tempo de ciclo. 



System Diagnostics Se o campo "Record cause of CPU STOP" está desativado não é enviada 
nenhuma mensagem para o PG / OP quando a CPU entra em STOP ("CPU  
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nenhuma mensagem para o PG / OP quando a CPU entra em STOP ("CPU  
Messages").

De qualquer forma a causa que levou a CPU ao estado STOP é armazenada no 
buffer de diagnóstico. 

Clock As possibilidades de sincronização dos relógios em rede são apresentadas no 
capítulo “Solução de Problemas”.

É possível também ajustar automaticamente a hora no relógio de uma CPU 
independente através de um fator de correção.                        

Correction Factor O fator de correção é utilizado para corrigir uma inexatidão do relógio após 
decorridas 24 horas. 

O fator de correção tanto pode ser negativo como positivo. 

Exemplo: Se o relógio está 3 segundos adiantado após 24 horas, isto pode ser 
corrigido com um fator de "-3000ms".

Nota "Interrupts", "Time-Of-Day Interrupts" e "Cyclic Interrupt" são discutidos no capítulo 
“Blocos de Organização".



Comunicação Toda conexão de comunicação ocupa um recurso de conexão (connection 
resource) na CPU do S7. Dependendo das especificações técnicas um número 
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resource) na CPU do S7. Dependendo das especificações técnicas um número 
específico de recursos de conexão está disponível para cada CPU, os quais são 
ocupados por várias tarefas de comunicação (“PG/OP communication”, “S7 
communication” ou “S7 standard communication”). 

Quando as tarefas de comunicação efetuam “log on” os recursos de comunicação 
são distribuídos na seqüência do “log on”.

A ocupação dos recursos de conexão não depende somente da seqüência de “log 
on” das várias tarefas de comunicação, pois é possível também reservar recursos 
para as seguintes tarefas:

• “PG Communication”; 

• “OP Communication”; e 

• “S7 Standard Communication”.

Ao menos um recurso de conexão para “PG/OP Communication” é reservado. 
Valores menores não são permitidos.

Outras tarefas de comunicação como “S7 Communication” com funções PUT/GET 
não podem ocupar este recurso de conexão mesmo se elas realizarem sua 
conexão primeiro. Pelo contrário, os recursos de comunicação ainda disponíveis 
mas não reservados para uma tarefa são ocupados.


